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Student Logins 
 
How do my students login? 
You will be emailed login instructions once your account has 
been setup and you have sent your class lists to MusicEDU. If you 
have not received this email, please get in contact with our team. 
_____________________________________________________________________ 
 
How do I reset a student's password? 
Watch The Video >> 
Students are able to reset their password by clicking on their 
name (top middle of screen) and following the prompts to RESET 
PASSWORD. 
 
If they forget their password, they are able to retrieve it from the 
website by clicking on "I've lost my password" under the LOGIN 
button. The website will send them an email to the email address 
provided to MusicEDU in the registration process (usually their 
school email address). 
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Alternatively, follow the steps below to reset a student's 
password: 
 
Step 1: Click on TEACHER ZONE (top middle of page near the 
drop down menu) 
Step 2: Locate the CLASSROOM tab (left-hand menu) & select the 
correct classroom 
Step 3: Locate & click on the Student's name 
Step 4: Click Reset Password 
Step 5: Press SAVE 
Step 6: To exit this area of the website, click on the ARROW next 
to your name, on the top left-hand side of the screen. You will be 
taken back to the normal LOGIN area for the MusicEDU website. 
_____________________________________________________________________ 
 
How do I edit a student's name or email address? 
Watch The Video >> 
Follow these steps: 
 
Step 1: Login to the MusicEDU website and click on TEACHER 
ZONE (top middle of the page near drop-down menu). 
Step 2: Locate the CLASSROOM tab (left-hand menu) and select 
the correct classroom. 
Step 3: Locate and click on the Student's name. 
Step 4: Edit the Student Name or Email Address. 
Step 5: Press SAVE. 
Step 6: To exit this area of the website, click on the ARROW next 
to your name on the top left-hand side of the screen. You will be 
taken back to the normal LOGIN area for the MusicEDU website. 
_____________________________________________________________________ 
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I'm seeing last year's/the wrong program when I login. What do I 
do? 
Use the drop-down menu on the top right-hand side to navigate 
between the programs you have access to. The website resources 
will align with the text for the corresponding year. If you don't 
see the programs you have subscribed to, please contact us and 
we will be in touch with you so that we can rectify the problem 
immediately. 
_____________________________________________________________________
Setting Up A Classroom 
 
How do I customise the portal for my students? 
Watch The Video >> 
_____________________________________________________________________ 
  
How do my students write their answers on the e-book? 
Watch The Video >> 
_____________________________________________________________________ 
  
How do I annotate on the .pdf worksheets? 
Watch The Video >> 
 
Instructions are provided for both Mac and Window users of how 
to annotate the PDF. Throughout these instructions, if you have 
any difficulties, please contact our team. 
  
Instructions for MAC Users: 

1. Open the worksheet. 
2. Click on the mark-up toolbar. It looks like a small lunchbox. 
3. You will see an extra line of options. 

--T: Text box. Click within the text box and type. Drag the text 
box to wherever you need. 
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--Font settings: these give you options for changing the font 
size, font style, etc. 
--Arrows/boxes: You can also add arrows or put a box around 
something. To move the arrow, grab the tip on one end; then 
grab the other end of the arrow and move it to where you 
need. 
--Sticky notes: The sticky notes are quite handy because you 
can type extended content. 

4. Save your document. 
5. Have your students upload their worksheets with their names 

saved in the title. This is an excellent way to teach your 
students the process of how to download a document, 
annotate on it, save it and then upload to the proper area. 

  
Instructions for Windows Users: 
  
All of the annotation tools are located on the Home tab. 

1. Click the Home tab. Then find the section named Annotations 
which gives you tools for text, sticky notes, highlighting, 
underlining, strikethroughs, and stamping. 

2. Text: To add text, click on Insert Note. The scroll-down menu 
gives you the choice to either insert a sticky note or a text 
box. 
--Sticky Note: You can click on the sticky-note icon or Insert 
Note. Click where you want to place the note and a yellow 
text box will appear where you can log your comment. To go 
back later and view the sticky note, just click on it. 
--Text Box: Under Insert Note, click on Insert Text Box. On 
your page, click where you want to type and a text box will 
appear. Enter your content. You can enlarge the text box by 
grabbing the edges to expand it. Or, at first, click and drag to 
start with a wider text box 
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3. Highlight, Underline & Strikethrough: See below for 
workarounds if these do not work for you. 

4. Click and drag: Any text box can be moved by clicking on it 
once and then dragging it to your selected area. 

5. Save your document. 
6. Upload: Have your students upload their worksheets with 

their names saved in the title. This is an excellent way to 
teach your students the process of how to download a 
document, annotate on it, save it and then upload to the 
proper area. 

_____________________________________________________________________ 
 
Why won't Highlight, Underline & Strikethrough Work? 
Because this is a scanned copy and not the original text, 
Highlight, Underline & Strikethrough might not work for you. 
There are workarounds for Underlining and Strikethroughs. Look 
to the right of the Annotation tools and you will see the Drawing 
Mark-up tools. You can use the line to underline and/or 
strikethrough. Click on the line. Click and drag where you want 
the line to be for either underlining and striking through a 
word/area. 
_____________________________________________________________________ 
 
Why does a message to install a plugin appear when I open the 
.pdf? 
If a message to install an OCR plugin appears when you open the 
.pdf file, you can ignore the message and just x-out of it. Due to 
this having to be a scanned copy so that students don't alter the 
page, Windows might show this message when you first open our 
.pdf file. 
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Window users, avoid this annotation difficulty: 
 Always annotate from the specified Annotation feature in the 
Home tab. If you mistakenly click on the Insert tab and use the 
text choice there, you will have difficulty adding text with that 
feature. Return to the Home tab and use the Annotation section. 
If the background breaks apart or you can no longer annotate, 
save your work, close and reopen. Then, only use the Annotation 
features. 
_____________________________________________________________________ 
 
How do I set up a classroom? 
Step 1: Download the attached MusicEDU Classroom template 
(found after these steps). 
  
Step 2: Add your students' details to the template and indicate 
which program/sessions you would like each classroom to see.  
  
Step 3: Upload the completed form via the link below and the 
team at MusicEDU will have your classrooms set up in the next 1-
2 business days.   
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Upload link: CLASSROOM UPLOAD HERE 
_____________________________________________________________________ 
  
How do I move a student to a different classroom? 
Watch The Video >> 
_____________________________________________________________________ 
  
How do I add an additional student to a classroom? 
If you have one or two new students to add to a classroom, 
please contact us with the inclusion of the student's first & last 
name, email address and the classroom you would like. 
_____________________________________________________________________ 
 
My school has a block on YouTube videos. How can my students 
still view these? 
Watch The Video >> 
All the YouTube videos are embedded on the Session pages and 
as teachers, it's most likely you are able to view them. If they are 
blacked out for the students, it means the school's proxy server 
has blocked them. You may be able to get IT to lift the block on 
them for the MusicEDU website. Alternatively, all the videos are 
saved on our server and are viewable by clicking on the video 
heading. Watch the video for full instructions. 
_____________________________________________________________________ 
  
How do I exit the classroom management system? 
Watch The Video >> 
To exit the Classroom Management area of the website, click on 
the ARROW next to your name on the top left-hand side of the 
screen. You will be taken back to the normal LOGIN area for the 
MusicEDU website. 
_____________________________________________________________________ 
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How do my students write their answers on the ebook? 
Watch The Video >> 
_____________________________________________________________________ 
   
How do I customise the portal for my students? 
Watch The Video >> 
____________________________________________________________________  

Quick Quizzes 
 
How do my students take a Quick Quiz or Revision Quiz? 
Watch The Video >> 
Each of the 10 Quick Quizzes, plus three revision quizzes are set 
up on the website. As a teacher, you will always be able to view 
these quizzes in your menu when you are logged in. 
  
Your students cannot see these with their login until you enable 
their class to take the quiz. 
  
Watch the video to see how to activate the quizzes (one at a 
time) for a class. You can also see how the website will mark 
their results and how to export the class results for your records. 
  
PLEASE NOTE: The video shows the year 2015, but all the details 
are current and relevant. 
_____________________________________________________________________ 
  
How do I export my student quiz results? 
Watch The Video >> 
 
You can export the results of an entire class or alternatively one 
student at a time to an excel spreadsheet. 
 



 MusicEDU Support & FAQ – Classroom Management 
 

 
9 

Step 1: Click on TEACHER ZONE (top middle of page near drop-
down menu). 
 
Step 2: Locate the CLASSROOM tab (left-hand menu) and select 
the correct classroom. 
 
Step 3: Select the Student Name you would like to export results 
from. 
 
Step 4: Click on the HISTORIES TAB (top right-hand side). 
 
Step 5: Press EXPORT to CSV. 
 
PLEASE NOTE: The video shows the year 2015, but all the details 
are current and relevant. 
_____________________________________________________________________ 
  
How do I export an entire classes' results? 
Watch The Video >> 
 
You can export the results of an entire class or alternatively one 
student at a time to an excel spreadsheet. 
 
Step 1: Click on TEACHER ZONE (top middle of page near drop-
down menu). 
 
Step 2: Locate the CLASSROOM tab (left-hand menu) and select 
the correct classroom. 
 
Step 3: Select the Classroom you would like to export results 
from. 
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Step 4: Scroll down past the student names and you will 
see HISTORIES. 
 
Step 5: Press EXPORT to CSV. 
 
Step 6: To exit this area of the website, click on the ARROW next 
to your name, on the top left-hand side of the screen. You will be 
taken back to the normal LOGIN area for the MusicEDU website. 
_____________________________________________________________________ 

Teacher Support 

 
We have a new teacher. How do I get them a login to the 
website? 
To receive login details for new teachers, send us a ticket with 
the following teachers' information: 

• First and last name 
• Email address 

  
We will get them set up on the MusicEDU website within 1 
business day. 
_____________________________________________________________________ 
  
Where can I find the answers to the Quick Quizzes? 
To find answers to the Quick Quizzes, log into the website and go 
to Teacher Resources > Suggested Answers. 
_____________________________________________________________________ 
  
Is there professional development available for teachers? 
Yes! Teachers are welcome to watch PD videos and accrue 
Professional Development hours. After watching the videos, your 
time will be automatically registered and MusicEDU will send you 
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a certificate. (You must watch the videos fully before our system 
will automatically register your time.) 
 
Watch The Video >>  
 
Steps to view the PD videos: 

1. Log into the MusicEDU website:  
2. Select the MusicEDU program from the drop-down menu in 

the top right hand side of the page. 
3. Look in the left sidebar and click on Teacher Resources. 
4. Within the Teacher Resources scroll-down menu you will 

see the PD categories. 

  
Each video series topic is categorized and the PD series topics 
include: 

• Music Technology PD 
• Curriculum PD 
• Programming PD 
• Student Differentiation PD 
• Video Game PD 
• Music software PD 

_____________________________________________________________________ 

 

 
 


